What is Animoto?
Animoto produces TV-quality music videos using your photos and video clips in just minutes.

It's so simple to do too. Choose a song as the soundtrack to your video and Animoto will analyze every nuance of it.
Producing a totally unique video each time, no two videos are ever the same.

Sharing them is a cinch as well. Add them to your MySpace & Facebook profiles, on your blog, e-mail them to friends,
put them up on YouTube or download them onto your computer.

Some of Animoto's founders used to produce shows for MTV, Comedy Central & ABC, study classical music in London,
play in rock bands in Seattle and develop software in Japan. They developed a patent-pending, Cinematic Artificial
Intelligence that thinks like an actual editor and director.

How do | get started?

Click "Create Video" from the set of buttons in the upper left to begin. Your first decision will be whether to make an
Animoto Short (a 30-second video) or a full-length video (extended length video). Video shorts are always free for
everyone and you can make as many as you want).

Animoto will then walk you through the three steps required to create a video. 1) Get your imagery, 2) Get music, and 3)
Finalize with details.

What do | need to use this site?

Briefly, you need a few software components: a web browser (which you have already if you're reading this), Javascript
turned on in your browser and Flash 9. You can check your version here.

Other than that, you'll need pictures or video clips, of course, to make a video.

Which browser is best to use?

For the best experience on animoto.com, on both Macs and PCs, we recommend you use Safari. In addition to Safari,
Firefox will work well too, though possibly not quite as well.

Animoto.com should work in Microsoft's IE6 and IE7 as well (and please let us know if they don't!). However, If you are
having difficulties, we suggest upgrading to Safari or Firefox.

While other browsers (Opera, Camino, etc.) should work fine, please note that the only browsers we formally support
are Safari, Firefox, IE6 and IE7.

How long will it take me to make a video?



It takes 3 minutes to render 30 seconds of video. If you are making a 10-minute video, this can take a while - even a
couple of hours. We suggest that if you need this for a school assighment or presentation for work, you make your video
the day before, to ensure that you have it in time.

Try downsizing large image files before you upload them to make the image upload stage fast, especially if you have a lot
of images.

What exactly is Animoto doing when it is creating my video?

Animoto uses patent-pending technology to analyze your images and everything about the selected music - its structure,
genre, energy, build, rhythm - before developing a blueprint for the motion design of your video. The remaining time is
spent rendering your video, using a giant farm of computer processors to custom-generate 15 new images per second
for your final video.

CREATING A VIDEO: Images

How many images should | use?
24-40 items (text, images, video clips) get displayed per minute of video depending on the song's tempo.

Animoto videos stop either when the music runs out or when there is no more imagery left to display... whichever
comes first. So, depending on the length and tempo of the song chosen, make sure that there are enough images to see
the song until its end, and conversely, that your song is long enough to show all the images that you'd like included in
your video.

If the video doesn't come out right in terms of timing, you can always do an Editing Remix to the video. Add/delete
images or switch-out the soundtrack, until your video is just right.

Do images have to be in a particular format or size?

Images must be in jpeg or gif formats and no larger than 5MB in size.
What's the difference between uploading and retrieving images?

Animoto gives you two ways to get your images. You can either UPLOAD them from your computer or have Animoto
RETRIEVE them from an online photo management site. We currently support direct image retrieval from Flickr,
Facebook, Smugmug, Picasa, and Photobucket.

If you have the choice, we recommend retrieving your images from your online photo manager since they are already
downsized for a faster upload. If the photos stored on your computer have a very high resolution (more than 1 MB in
size), you may want to downsize them first to reduce upload time if you plan to make videos to share online. We
recommend downsizing to no less than 640x426 (or about 50kb per image), and no more than 1024x768 (or about
100kb per image).

If you plan to make videos for DVD or to download onto your computer, it's best to upload images that are at least
1024x768--but still, no need for pics more than 1 or 2 megapixels.
How do | upload images?

To upload images when you are creating a new video or editing an existing video, click the 'UPLOAD' button in the
'IMAGES' section. Navigate through your computer files to where your digital images are stored. To select multiple files,



hold down the 'CTRL' or 'SHIFT' keys while clicking on the files. Upload time will depend on your Internet connection and
the file size of each image.

If your pictures are already uploaded to an online photo management site, we recommend RETRIEVING your images
since they will already be downsized and will save you significant time. We currently support direct image retrieval from
Flickr, Facebook, Smugmug, Picasa, and Photobucket.

How do | downsize images for faster uploading?

Images straight off your digital camera can be 100 times what you actually need for an online video. Although you can
upload very high resolution images, smaller downsized images work just as well and save you significant upload time.
You can use simple image-resizing programs to downsize your images to a smaller size. If you have a Mac, we
recommend using DroPic! (free). If you have a PC, we recommend using VSO Image Resizer (free). These are easy-to-use
tools to help you resize your images to something appropriate for the web. We recommend a size of no less than

640x426 (about 50kb per image), and no more than 1024x768 (about 100kb per image).

If you plan to make videos for DVD or to download onto your computer, it's best to upload images that are at least
1024x768--but still, no need for pics more than 1 or 2 megapixels.

What is the image spotlight feature?

The spotlight feature allows you to tell Animoto to place special emphasis on certain images when producing the video.
You can spotlight as many images as you want. Simply click the thumbnail of the image you want featured to select it
(holding CTRL if you want to select more than one), and then click "spotlight".

Can | add text to my video?

Yes, you definitely can!

After UPLOADING or RETRIEVING your images, you'll see a row of buttons beneath them. One of them has a "T" on
them. That's the text feature. Click it to add text to your video.

Do you have an image enlargement feature for when I'm prepping my video?

Yes, definitely. Double click on the image while in the IMAGE stage of prepping your video, and you'll see that an
enlarged version of your image will appear toward the right. This makes it a lot easier to decipher which image is which.
What are the keyboard shortcuts to delete, rotate and spotlight images?

Beneath the images are buttons that do all these functions. But to save time, you can also highlight the image(s) you'd
like to delete and press "D" on your keyboard. To rotate press "R" and to spotlight your images press press "S."
CREATING A VIDEO: Video

What video formats does Animoto support?

We support quite a few video formats and codecs. However, there are many different video file types that use
proprietary encoding formats, so you won't know if we support them or not until you try uploading.



Here are the file extensions we currently support: mp4, avi, mov, qt, 3gp, mdv, mpg, mpeg, mp4v, h264, wmv, mpg4,
movie, m4u, flv, dv, mkv, mjpeg and ogv.
What's the maximum size of video file which | can upload?

200Mb.

How long can a video file be?

Depends on the resolution. Our cap is 200MB, which means that we'll be able to accept longer videos of smaller
resolution or shorter videos of higher resolution.

Can | decide what part of my footage gets included in my Animoto video? If so, how?

You can click on any uploaded video clip to preview it. Move the "DRAG TO SET CLIP START" icon to choose the
beginning of your video clip. If you click the "EDIT" button beneath the preview window, you can modify both the start
point and length of your video clip.

It says my video can't be uploaded/I get an error. What's causing this?

Many devices create videos using proprietary video formats that we can't support. We're actively working on supporting
as many formats as we can. Anytime a video fails during the upload process, we keep information about the file to

better help us understand how to support similar file types in the future.

If it's not your own music or Creative Commons music, then you'll need to make sure you have permission to use the
music you want.

Make sure to take a good look at Animoto's Terms of Service (the binding contract that must be accepted upon
registering). We've made the distinction between music that's acceptable for upload and music that's not acceptable for
upload as clear as possible.

If upgrading to DVD-Quality, what resolution should my video be?

At least 720x480 pixels at 24fps (DVD quality).

What resolution should my video be for optimal online viewing?

At least 432x240 pixels at 15fps.

Can | upload only video or must | include images as well?

Yes, you can definitely upload only video!

Can my video have audio in it?



You video's audio is on by default. The music chosen for your video's soundtrack will be a lower volume so that your
footage's audio makes it into your Animoto video.

Can | mute my video's audio?

You video's audio is on by default. To mute it, click on the video clip and notice that the preview area comes up to the
right. There you can opt into muting the audio in your video footage.

CREATING A VIDEO: Music

How do | get music?

To choose a music soundtrack when you are CREATING a new video or REMIXING an existing video, click 'UPLOAD' or
'SELECT' in the MUSIC section.

To UPLOAD, navigate through your computer files where your digital music is stored. Upload time will depend on your
Internet connection and the file size of your song. Typically it will take about 1-2 minutes to upload a 3MB MP3 file with
a high-speed internet connection.

Does my music have to be in any particular format?

Animoto currently accepts any MP3 format. Unfortunately, if you've purchased any music from iTunes and it's in .M4A
format, you won't be able to use it with Animoto.

Is there a time-limit on how long a song can be in a video?

Yes, currently we don't allow songs that are longer than 10 minutes & bigger than 10 MB in size.

Can | use more than one song in a video?

Only one song can be selected per video.

What kind of music can | upload?

One of the most popular uses of Animoto is when bands, artists, or music labels make their own instant music videos to
share with their own music. Some bands even share videos after every gig they play.

You can also use most Creative Commons music which is offered restriction free and at no cost. There are millions of
tracks being offered for free from sites that support Creative Commons music like Jamendo, Dmusic, Opsound, and
Soundclick. (see 'What is Creative Commons music?' below)

If it's not your own music or Creative Commons music, then you'll need to make sure you have permission to use the
music you want.

Make sure to take a good look at Animoto's Terms of Service (the binding contract that must be accepted upon
registering). We've made the distinction between music that's acceptable for upload and music that's not acceptable for
upload as clear as possible.



What is Creative Commons music?

There is a fast growing number of artists who today are choosing to offer their music for free under Creative Commons
licensing, an alternative to the traditional ways that artists are able to get their music out there and heard. Basically, it
allows artists to choose what restrictions they'd like to place on each of their songs and many are offered for free to
download and can be used for derivative works. Today, millions of music tracks are being offered by services like
Jamendo, Dmusic, Opsound, Soundclick under Creative Commons licensing. For more information, go to
creativecommons.org.

What's the point of changing the start point of the music?

Many songs start with some dead time or with a build-up that you might not want to include in your ANIMOTO video.
With the song Start Point Slider, you can tell us where to start your song. Press 'PLAY' and wait until just the right
moment; then press 'PAUSE'. If you are making an Animoto Short and have selected a song from our collection, the Start
Point Slider will be disabled since a customized 30-second version of the song has already been edited for you. Nice,
huh.

I'VE FINISHED MY VIDEO--NOW WHAT?
How do | know when my video is complete?

It takes about 3 minutes to render 30 seconds of a video. This can sometimes take longer (or shorter) depending on how
much traffic our site has. The render status page will automatically update to let you know the status of your video's
production. When your video is complete, it will automatically replace the status page and be waiting for you to view.

Your final video will also be in your 'MY VIDEQOS' collection. You will also be notified by email the very second your video
is ready and a direct link to the video will be included. So, feel free to minimize your web browser and go have a pizza
pocket during the rendering process if you don't want to wait around. Better yet, produce some more videos.

Where can | find my new video?

When your new video is complete, you can find it in your 'MY VIDEOS' inbox along with all the other videos you've
created. You will also be notified by email the very second your video is ready and a direct link to the video will be
included.

How do | remix a video?

You can find the blue "VIDEO TOOLBOX" button beneath your video. Clicking this button will give you the option to ONE-
CLICK REMIX or EDITING REMIX your video.

What is a One-click Remix?

Animoto produces completely unique videos. No two videos are ever the same. ONE-CLICK REMIXING lets you see what
else Animoto can come up with using the same images, music, and details a video already has. It sends your project
through one more time and produces a whole new video. Whether it's an Animoto Short or full-length video, you can
remix as many times as you want and choose your favorite result. Don't worry about losing past versions because each
time you remix, Animoto makes a copy of your project and creates a whole new video.



What is an Editing Remix?

'EDITING REMIX' opens the video project and allows you to add and/or delete images in an existing video, rearrange
images, or change the soundtrack. Don't worry about losing past version because each time you REMIX a video, Animoto
makes a copy of your project and creates a whole new video.

How do | remix a video?

You can find the blue "VIDEO TOOLBOX" button beneath your video. Clicking this button will give you the option to ONE-
CLICK REMIX or EDITING REMIX your video.

WATCHING A VIDEO

How do | watch videos that I've created?

All videos that you have created will be in your 'MY VIDEOS' inbox where you can choose to 'PLAY', 'EDIT', or 'DELETE'.

How do | watch videos that my friends have sent me?

All videos that have been sent to you by friends will be in your 'VIDEOS FROM FRIENDS' inbox where you can choose to
'PLAY' or 'DELETE".

Can anyone else watch my videos?

All videos are totally private unless you active share your video's link with others/post it elsewhere. No one can stumble
across, search for or access your video without you allowing them to.

How do | watch my video fullscreen on my monitor?

To watch your video fullscreen, simply click on the fullscreen video button on the Video Player. It's the button to the of
the volume control. If nothing happens (or if the video just appears to stop), you probably have a pop-up blocker on.
Make sure to allow pop-ups from Animoto.com.

SHARING A VIDEO

How do | share a video?

You can find the blue "VIDEO TOOLBOX" button beneath your video. Clicking this button will give you the option to e-
mail the video out to friends or post it to a site like Facebook or your blog.

If you e-mail the video to a friend who is registered already, your video will then show up in their VIDEOS FROM FRIENDS
collection.

How do | email a video?



You can find the blue "VIDEO TOOLBOX" button beneath your video. Click on the "SHARE" option to e-mail your video to
your friends & family.

You'll also notice that there is a small button with an envelope on it on top of your video & toward the right. E-mail the
video out easily that way too.
How do | post a video to my MySpace or Facebook page?

You can find the blue "VIDEO TOOLBOX" button beneath your video. Click on the "SHARE" feature to post to popular
sites like MySpace or Facebook.

Don't see the site or blog provider you want to post to there? Then click on "More Options" to see the other sites you
can post to.

I have a Facebook Fan/Business page. How do | post to that?

You can't post your online video to a Fan/Business page on Facebook. However, you can download the mp4 of your
video and then manually upload to your Fan/Business page.

How do | post a video to YouTube?

You can find the blue "VIDEO TOOLBOX" button beneath your video. Click on the "EXPORT" feature to post to YouTube.

How do | embed a video onto my website?
You can find the blue "VIDEO TOOLBOX" button beneath your video. Click on the "EMBED" feature to nab your code.

We provide three different sizes so that your video can easily fit into your site.

I've posted my video to Facebook--now where is it?

At the moment, videos posted to Facebook will show up in the "Wall" portion of your profile as a "Posted Item."
While we do have a popular Facebook app that lets you make videos on Facebook, tag friends in the video, and share
your videos via the app, we can't currently link up videos made at animoto.com to the app.

How do | embed a video into my WordPress Blog?

You can find the blue "VIDEO TOOLBOX" button beneath your video. Click on the "SHARE" feature and then on "More
Options" (beneath the Facebook, Twitter icons) to post your video to other sites like WordPress.

How do | load a video onto my iPod or iPhone?

Animoto has an iPhone/iPod Touch app that allows you to easily make videos on your iPhone. You can also link-up your
animoto.com account with your iPhone vids as well!



How do | download a video to my computer?
You can find the blue "VIDEO TOOLBOX" button beneath your video. To the right you can see where you can download

the standard-quality mp4 download (if it's a full-length video) or upgrade your video to a hi-res download.

ANIMOTO SHORTS & FULL-LENGTH VIDEOS
What's the difference between an Animoto Short and a full-length video?

Animoto Shorts are 30-seconds in length and free for everyone. You can produce, remix, and share as many as you'd
like.

Full-length videos can be as long as a whole song and are downloadable.

How do | make a full-length video?

The process for making a full-length video is the same as an Animoto Short except that a full-length video requires a
video credit. You can see how many full-length videos you have in the upper-right Session Box. Making a full-length
video will deduct one credit.

How much will a full-length video cost me?

Animoto Shorts are free. You can make, share, and remix as many as you want. Producing a full-length video costs $3
and includes the ability to download the video to your computer. You may buy as many individual full-length video
projects as you wish. An All-Access Pass, which allows you to make an unlimited number of full-length videos for one
year, costs $30. With an All-Access Pass, you can download any of your videos, whether they're Video Shorts or full-
Length videos.

What are the limits of a full-length video?

Animoto will accept images up to 5MB in size for each file, and music up to 10MB in size. Videos also can't be longer
than 10 minutes, so as not to clog up our system with insanely huge projects.

What is an All-Access Pass?

An All-Access Pass allows you to produce an unlimited number of full-length videos for one year. You can also download
any of your videos, whether they're Video Shorts or full-length videos.

How much is an All-Access Pass?

You can get an All-Access Pass for $30. That allows you to produce an unlimited number of full-length videos for one

year. You can also download any of your videos, whether they're Video Shorts or full-Length videos. To get an All-Access
Pass, click here.

Why do we charge?



The main reason we charge has to do with the intensity of our video production process. In order to be able to offer
something different from what's out there on the web, namely the type of "high-end" motion design and effects used in
TV & film, we actually have to produce from scratch EACH new frame of your Animoto video... and there are 24 frames
in each second of video! As you can imagine, this takes massive amounts of processor power, so we unfortunately can't
afford to give everything away for free, particularly full-length videos, which really have intense demands on our render
system. Fun fact: did you know it takes Pixar Studios 408 hours to render each second of their films using 3000
computers? Makes what we're doing here at Animoto seem pretty wimpy.

What happens when my All-Access Pass expires?

When your All-Access Pass expires, you will be notified by email. You can also find out when your All-Access Pass expires
by clicking on the '"ACCOUNT' in the upper-right Session Box. When your All-Access Pass expires, you will still have full
access to all your videos; they will not be deleted.

ANIMOTO DOWNLOADS

What are Animoto Downloads?

Animoto Downloads are full-length videos in a file-format that can be saved to your hard drive and played on your
computer. You will need QuickTime to play an Animoto Download. (Hint: If you have iTunes, you already have
Quicktime). The file size will be roughly 5 to 6 MBs per minute of video. Animoto Downloads are available only for full-
length videos, that is, unless you have an All-Access Pass. With an All-Access Pass you can download not only your full-
length videos but Video Shorts as well.

How can | use Animoto Downloads?

You can upload these videos to YouTube, post them to your blog, load them on you iPod or iPhone, or do whatever you
want with them. Most users want to download videos in order to play them when an internet connection is not
available. They can come in handy for video projections, class presentations, concerts, weddings, conferences, meetings,
and other events.

How much do Animoto Downloads cost?

Animoto Downloads are being offered at no extra cost for all full-length videos. You will need a full-length video credit or
an All-Access Pass to produce a full-length video. Animoto Downloads are available only for full-length videos, that is,
unless you have an All-Access Pass. With an All-Access Pass you can download not only your full-length videos but Video
Shorts as well.

How do | download an Animoto video to my computer?

Click the 'VIDEO TOOLBOX' button beneath the video. On the right, there will be options for downloads.

What format, resolution, and file size are Animoto Downloads?

Animoto Downloads are available in .MP4 (H.264) format. You will need QuickTime to play the video.(Hint: If you have
iTunes, you already have QuickTime). The file size will be roughly 5 to 6 MBs per minute of video. Animoto Downloads
have a resolution of 432x240 and can be expanded to play full screen on your computer. They look great for all general
computer usage. They should also pass as decent video projections concerts, wedding, conferences, meetings, and other
events. If you're looking for a hi-res DVD-quality version of your Animoto video, check out the section below.



How long does it take to prepare a video file to be downloaded?

No time at all. We've done all the work while your video was originally being rendered. Thus, all full-length videos are
available for immediate download and will not require any additional time to render. However, older videos made prior
to 12/18/07 require a few minutes to convert and re-render into a downloadable format.

How do | view an Animoto Download in full screen mode?

Make sure you are using QuickTime to play your video. If you have a PC:
Choose View > Full Screen or use the keyboard equivalent,

Control-F. Press the 'Esc' key to exit fullscreen mode. If you have a Mac:
Choose View > Enter Full Screen or use the keyboard equivalent,
Command-F. Press the 'Esc' key to exit fullscreen mode.

Where did my video download to?

Your computer will have you specify where exactly you'd like your downloaded video to be saved after clicking
'DOWNLOAD'. Typically, videos get downloaded to your Desktop or your 'Download's directory. If you can't find your
video file, try downloading it again and make sure to note the specified download location.

What if | have a Video Short | want to download?

If you have an All-Access Pass, you can download any of your videos. Otherwise, only full-length videos are available for
download. If you wish to download a video that's currently a Video Short, you'll first have to convert it to a full-length
video and re-render it. To do this, click 'EDITING REMIX' and on the Finalize tab, click the 'FULL-LENGTH' option. Click
'CREATE VIDEQ' and upon being re-rendered, your video will be available for download.

DVD-QUALITY OPTIONS

Can | burn the download to DVD?

Check out the DVD-quality download section below, to learn about downloads that are specifically designed to be
burned to DVDs. The downloads that are included in the price of full-length videos aren't really suitable for burning.

If you have a PC: Choose View > Full Screen or use the keyboard equivalent, Control-F. Press the 'Esc' key to exit
fullscreen mode.

If you have a Mac: Choose View > Enter Full Screen or use the keyboard equivalent, Command-F. Press the 'Esc' key to
exit fullscreen mode.

What can | do with DVD-quality Animoto videos?

We want you to be able to use your Animoto videos whenever, wherever, and however you want.

With these DVD-quality options, you'll be able to play your Animoto video with a DVD player on a big screen, or project
it even larger at a wedding, concert, birthday party or anywhere else.



How much are DVD-quality videos?

Ordering a DVD costs $21.99 USD + shipping and handling.

We also offer the option to download the DVD-Quality files (which you can then burn to DVD yourself) for $5 USD. The
upgrade includes two types of files, .ISO and .MP4. The .ISO file can be burned onto a blank DVD while the .MP4 file can
be played directly on your computer using Quicktime.

Do DVD-quality videos have the Animoto logo?

If you get an Animoto for Business or Animoto for Photography package, the option to remove the Animoto logo is
available to you. If, however, you upgrade your video made with a consumer All-Access Pass/full-length credits, the logo
will still be there.

When creating a video | intend to later upgrade to DVD-quality, what resolution images should | use?

To ensure that your video in rendered at its highest possible quality with this option, you should use images that are at
least 1000 on a side, or 1000 x 1000, when making your video.

What resolution quality are these videos?

DVD-quality downloads are 864 x 480 and rendered at 24 frames-per-second. (Standard Animoto videos are 432 x 240
and rendered at 15 frames-per-second.) DVD-quality videos look great when played on a large screen TV or projected

onto a wall or projection screen.

To see a side-by-side comparison of a standard Animoto video vs. DVD-quality Animoto video, click here:
http://biz.animoto.com/dvd/comp.html

Do you have a sample showing what the DVD-quality videos look like?

To see a side-by-side comparison of a standard Animoto video vs. DVD-quality Animoto video, click here:
http://biz.animoto.com/dvd/comp.html

What format do the downloaded DVD-quality videos come in?

We offer two file types for DVD-quality videos to be downloaded: .ISO & .MP4. The $5 USD upgrade charge includes the
preparation of both files types for you.

DVD-quality downloads come in both an mp4 formatted file (to be played on your computer using QuickTime) & an ISO
formatted file (which can be burned to a DVD for TV-viewing).
How long does it take to render a DVD-quality download?

It takes about 20-30 minutes to render each minute of your video. Since we are re-rendering these videos frame-by-
frame at a higher resolution, they take longer than the rendering of standard Animoto videos.

Note: You don't have keep your computer on or stay on the animoto.com website while you video is rendering. We'll e-
mail you once your video is ready to download.
How do | burn a DVD-quality download on a Mac?



1. Insert a blank disc.

2. Start Disk Utility from your Application Folder

3. From the File menu, choose Open Disk Image and select your downloaded ISO file to be burned.
4. In the list of volumes, you will now see an item representing the I1SO file. Select it.

5. Click the Burn button and follow the instructions.

How do | burn a DVD-quality download on a PC?

If you don't already have a DVD-burner incorporated in your computer, or if you are having trouble burning Animoto
videos to DVD on a Windows platform, we have identified free burners that are Animoto-compatible.

We recommend Active Burner or IMGBurn for XP Machines & I1SO Recorder for Vista Machines.
ANIMOTO FOR BUSINESS

What is Animoto for Business?

Animoto for Business is a platform that allows businesses to use Animoto's cutting-edge, high-end & cost-effective video
production technology to create stunning video in just minutes.

With quick turn-around times & a whole slew of features that make Animoto for Business especially useful for
businesses, our platform lets you keep your company's messaging, marketing, and website relevant in an easy-to-do
way.

What features are included in Animoto for Business?

The White Label feature allows your video to be devoid of any Animoto logo/branding. The 300+ free-to-use songs in our
Commercial Music Library save you both time & money in finding commercially licensed music.

Free DVD-Quality download upgrades are included as well, as is the Call-to-Action button. This button allows you to add
a link to your website at the end of the video. Drive traffic to your site this way.

What's the difference between Animoto for Business & Animoto for Photography/Real Estate?

Animoto for Photography & Animoto for Real Estate contain the same features. We just wanted to specifically show how
different industries were using our Animoto for Business platform. May it be photographers re-selling videos to clients
or realtors wowing customers with engaging video, there is a plethora of ways to use our service to meet your business
needs.

How big a deal is the commercially licensed library?

We did all the heavy-lifting for you by finding commercial tracks. Finding commercial music can be both time-consuming
& expensive when done on your own. Many licensing companies charge upwards of $60 per track for commercially
licensed tunes. To make Animoto all the more cost-effective to you, we provide you with 300+ songs in 10 different
genres so that you needn't worry about finding just the right song.

It should be noted that the commercial music library is different than the consumer library due to the licensing. You're
able to check out the commercial library before buying. To do this, sign-out of our site, then click on the Music Lounge
option. You'll then be given the option to peruse the commercial music library.



How do | access the Call-to-Action & Speed Control features once I sign-up for A4B?

While in the "Finalize" stage of prepping your video, you'll see an area where you can type in both a URL & a name for
the Call-to-Action button. In that same area, you'll also see the ability to choose between the half-speed, default/normal
tempo & double speed.

Do videos have an Animoto logo?

The Animoto for Business/Photography package includes a White Label feature, which lets you opt out of having
Animoto-branding in your videos. Our commercial offering is the only package available at our site that is devoid of our
logo.

Can I resell these videos?

Our Terms of Service allow you to resell videos to individuals (i.e. a photographer selling a video to a client after a photo
session). However, we don't allow videos to be sold in a business to business context (i.e. a marketing company making
and selling videos to a company with which they are working).

| speak at conferences & workshops. Do you have a program for me to promote Animoto for Business?
Yes, we have an affiliate program. Albeit, the affiliate program is more web-based friendly (i.e. you promoting us on your

site), but we would still be happy to hear from you if you are speaking at any upcoming seminars and would like to
promote our service there. Write to theteam@animoto.com to see if we can work something out.

COPYRIGHTS & LICENSES
Do | retain copyrights and other legal rights to my videos?

Yes. You retain all rights to your content. Animoto assumes no copyright to your material.

What is your policy on copyright?

Animoto absolutely respects the rights of copyright holders for images and music. Our policy is to respond to any notices
of alleged infringement that comply with the Digital Millennium Copyright Act (DMCA), including removing the content
immediately. Animoto reserves the right to terminate your account and video creations in accordance with our Terms of
Service.

How do | report copyright infringement?

If you believe that someone else has infringed upon your copyrighted content without your permission, please follow
the directions in our DMCA policy.

What if | have been falsely accused of copyright infringement?

We'll let you know if we receive a copyright complaint about any of your video content that is hosted on Animoto. We'll

give you the opportunity to file a DMCA counter notification as outlined in our Terms of Service.

Where did you get your icons on the player page?



We got them from Function Web Design. You can get them, too, for free!

TROUBLESHOOTING
Why can't | see my video?

There are a number of reasons you may not be able to see your video:

The usual culprit is Flash, which you need to have installed. You need version 9 or above and you can check your version
here.

The next likely candidate is Javascript, which you may have turned off in your browser. This one will pretty much disable
the entire site, though, so it's unlikely you've got it turned off if nothing else is giving you problems.

Lastly, it is possible that another piece of software on your computer, such as a firewall or anti-virus program, is causing
an issue. Have you got Norton Firewall, for example? If so, you may need to allow the Flash player to access the external
video file by adjusting some settings.

After you have made any of these changes, do a full page refresh (clearing cache) by holding CTRL or SHIFT (different for
each system) while pressing the refresh button.

If none of these works, please contact us using the "Got feedback?" button in the corner of this screen. Thanks!

Why isn't my entire song featured in my video?

Animoto videos stop either when the music stops or when there are not more images left to display... whichever comes
first. So, make sure that there are enough images to sustain your song and that your song is long enough to display all
your images. If you are producing an Animoto Short, videos can be up to 30-seconds in length.

I lost my connection in the middle of uploading. Where can | find the images that have already been uploaded?

Sign in to Animoto again, click "create video" in the upper-left corner, and you will be directed straight to the imaged
upload screen right where you left off and any images that have already been uploaded will be there. Click the 'GET
MORE' button to continue uploading additional images.

I'm having problems on Leopard. What's the deal?

Ahh Leopard...such a beautiful animal, such a beautiful new OS X. If you're having problems uploading, it is because
Adobe's Flash player has some incompatibilities with Leopard and you will need to get their newest fix here. If you are
experiencing other problems unrelated to the uploader, please let us know through the feedback button!

Where are my iPhoto photos on my mac?

When uploading your images to Animoto, you can find your images in iPhoto by clicking on Pictures->iPhoto Library-

>Modified. Unfortunately, iPhoto only stores your photos in batched that you've imported them. It refers to these as
"Rolls". Your mac does not keep your photos in albums or sets that you may have created in iPhoto.

Why aren't all my images appearing in my video?



The number of images uploaded may exceed the amount of time that the music you've chosen allows. Alternatively, if
you're producing an Animoto Short, images that don't fit within the 30-seconds limit will be left out.

My images go by too fast. How do | slow them down so | can see them?

All Animoto visuals are designed to intelligently respond to the genre, structure, rhythm, and energy of your music. By
REMIXING the video to a more mellow tune, your images will appear at a slower pace. You can also choose to
SPOTLIGHT certain images which will place more emphasis on them in the video by featuring them more prominently.
Also, we will almost certainly be offering addition user control over speed in the near future. Also, full-length videos
have a Speed Control feature that allows you to make the video go at half-speed (or double-speed).

How do | contact you?

Head to the contact page for options. We'd love to hear from you and answer any questions that you might have.

How do | play a downloaded video?

You will need QuickTime to play the video. If you have iTunes, you already have Quicktime.

Where did my video download to?

Your computer will have you specify where exactly you'd like your downloaded video to be saved after clicking
'DOWNLOAD'. Typically, videos get downloaded to your Desktop or your 'Downloads’ directory. If you can't find your
video file, try downloading it again and make sure to note the specified download location.

How do | download a Video Short?

If you have an All-Access Pass, you can download any of your videos. Otherwise, only full-length videos are available for
download. If you wish to download a video that's currently a Video Short, you'll first have to convert it to a full-length

video and re-render it. To do this, click 'EDITING REMIX' and on the Finalize tab, click the 'FULL-LENGTH' option. Click
'CREATE VIDEQ' and upon being re-rendered, your video will be available for download.

CONTACT US

How do | contact Animoto?

To contact us, head to the CONTACT PAGE. We'd love to hear from you and answer any questions that you might have.
We promise to get back to you asap.

How do | inquire about partnership opportunities with Animoto?

To contact us, head to the CONTACT PAGE. We'd love to hear your ideas of working with us! We're always open to new
ideas.

All information on this handout directly from: http://animoto.com/help/faq



